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Preface

Welcome to the Oracle Enterprise Install Base User Guide, Release 11i.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.
ix



How To Use This Guide
This document contains the information you need to understand and use Oracle 
Enterprise Install Base.

■ Chapter 1, "Understanding Oracle Enterprise Install Base," provides overviews 
of the application and its components, explanations of key concepts, features, 
and functions, as well as the application’s relationships to other Oracle or 
third-party applications.

■ Chapter 2, "Understanding Inventory Integration," provides an overview of the 
transactions and the processes in Oracle Inventory that are associated with 
Oracle Enterprise Install Base.

■ Chapter 3, "Understanding Asset Deployment," describes how to perform asset 
deployment transactions to track your products and assets.

■ Chapter 4, "Understanding Projects Integration," provides an overview of the 
transactions and the processes in Oracle Projects that are associated with Oracle 
Enterprise Install Base.

■ Chapter 5, "Understanding Fixed Asset Integration," provides insights into the 
integration of Oracle Enterprise Install Base and Oracle Assets.

■ Chapter 6, "Using Oracle Enterprise Install Base," provides process-oriented, 
task based procedures for using Oracle Enterprise Install Base to perform 
essential business tasks.
x



Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation 
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor 
makes any representations regarding the accessibility of these Web sites. 
xi



Other Information Sources
You can choose from many sources of information, including documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Enterprise Install Base.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). 

■ PDF Documentation - See the Documentation CD provided with each release 
for current PDF documentation for your product. This Documentation CD is 
also available on OracleMetaLink and is updated frequently.

■ 11i Release Content Document - Refer to the Release Content Document for 
new features listed release. The Release Content Document is available on 
OracleMetaLink.

■ About document - Refer to the About document for patches that you have 
installed to learn about new documentation or documentation patches that you 
can download. The new About document is available on OracleMetaLink.

Related Guides
Oracle Enterprise Install Base shares business and setup information with other 
Oracle Applications products. Therefore, you may want to refer to other guides 
when you set up and use Oracle Enterprise Install Base.

You can read the guides online by choosing Library from the expandable menu on 
your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Guides Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI). This guide also includes information on setting user 
profiles, as well as running and reviewing reports and concurrent processes.
xii



You can access this user’s guide online by choosing “Getting Started with Oracle 
Applications” from any Oracle Applications help file.

Guides Related to This Product

Oracle Enterprise Install Base Implementation Guide
This guide provides information required for implementing and setting up 
Installation and System Administration.

Oracle Inventory User’s Guide
This guide provides overviews of the Oracle Inventory application and its 
components, explanations of key concepts and features.

Oracle Projects User’s Guide
This guide provides overviews of the Oracle Projects application and its 
components, explanations of key concepts and features.

Oracle Assets User’s Guide
This guide provides overviews of the Oracle Assets application and its components, 
explanations of key concepts and features.

Oracle Purchasing User’s Guide
This guide provides overviews of the Oracle Purchasing application and its 
components and features and functions.

Oracle Payables User’s Guide
This guide provides overviews of the Oracle Payables application and its 
components, explanations of key concepts and features.
xiii



Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications 
and the Oracle technology stack by automating many of the required steps. This 
guide contains instructions for using Oracle Rapid Install and lists the tasks you 
need to perform to finish your installation. You should use this guide in conjunction 
with individual product user guides and implementation guides.

Oracle Applications Implementation Wizard User Guide
If you are implementing more than one Oracle product, you can use the Oracle 
Applications Implementation Wizard to coordinate your setup activities. This guide 
describes how to use the wizard.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

“About” Document
For information about implementation and user documentation, instructions for 
applying patches, new and changed setup steps, and descriptions of software 
updates, refer to the ”About” document for your product. ”About” documents are 
available on OracleMetaLink for most products starting with Release 11.5.8.
xiv



Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff and describes the Oracle Application Object Library components 
that are needed to implement the Oracle Applications user interface described in 
the Oracle Applications User Interface Standards for Forms-Based Products. This manual 
also provides information to help you build your custom Oracle Forms Developer 
forms so that the forms integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle Applications Product Update Notes

Use this guide as a reference for upgrading an installation of Oracle Applications. It 
provides a history of the changes to individual Oracle Applications products 
xv



between Release 11.0 and Release 11i. It includes new features, enhancements, and 
changes made to database objects, profile options, and seed data for this interval.

Oracle Workflow Administrator's Guide
This guide explains how to complete the setup steps necessary for any Oracle 
Applications product that includes workflow-enabled processes, as well as how to 
monitor the progress of runtime workflow processes.

Oracle Workflow Developer's Guide
This guide explains how to define new workflow business processes and customize 
existing Oracle Applications-embedded workflow processes. It also describes how 
to define and customize business events and event subscriptions.

Oracle Workflow User's Guide
This guide describes how Oracle Applications users can view and respond to 
workflow notifications and monitor the progress of their workflow processes.

Oracle Workflow API Reference
This guide describes the APIs provided for developers and administrators to access 
Oracle Workflow.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Enterprise Install Base implementation team, as well as for users responsible 
for the ongoing maintenance of Oracle Applications product data. This guide also 
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on OracleMetalink
xvi



Oracle Applications Message Manual

This manual describes all Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.
xvii



Support

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Enterprise Install Base 
working for you. This team includes your technical representative, account 
manager, and Oracle’s large staff of consultants and support specialists with 
expertise in your business area, managing an Oracle server, and your hardware and 
software environment.
xviii



Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle develops and markets an integrated line of software products for database 
management, applications development, decision support, and office automation, 
as well as Oracle Applications, an integrated suite of more than 160 software 
modules for financial management, supply chain management, manufacturing, 
project systems, human resources and customer relationship management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
xix



Your Feedback
Thank you for using Oracle Enterprise Install Base and this user guide.

Oracle values your comments and feedback. In this guide is a reader’s comment 
form that you can use to explain what you like or dislike about Oracle Enterprise 
Install Base or this user guide. Mail your comments to the following address or call 
us directly at (650) 506-7000. 

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
U.S.A.

Or, send electronic mail to appsdoc_us@oracle.com.
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Understanding Oracle Enterprise Install B
1

Understanding Oracle Enterprise Install

Base

This topic group provides overviews of Oracle Enterprise Install Base and its 
components; explanations of key concepts, features, and functions; and explanation 
of the application’s relationships to other Oracle or third-party applications. 

1.1 Overview of Oracle Enterprise Install Base
Oracle Enterprise Install Base is a fully integrated solution in the Oracle E-Business 
suite designed to deploy and track internal products and assets at internal or 
customer sites, while providing the ability to capture financial transactions with 
back-office automation. 

With Oracle Enterprise Install Base, you can give users access to tracking 
information without allowing them access to sensitive processes related to assets 
and purchasing. You can also track inventory items after they have been installed 
and link financial transactions to the physical movement of equipment.

Oracle Enterprise Install Base integrates with Oracle Inventory, Oracle Purchasing, 
Oracle Projects with the Capital Resource Logistics (CRL) feature, Oracle Assets, 
Oracle Payables, and Oracle Install Base, and stores information collected from 
them.

1.1.1 Summary of Oracle Processes that Track Internal Products and Assets
The following diagram shows a summary of the Oracle application modules and 
the transactions associated with Oracle Enterprise Install Base.
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Overview of Oracle Enterprise Install Base
Figure 1–1 Summary of Oracle Processes that Track Internal Products and Assets

1.1.2 Oracle Install Base Integration
The Oracle Install Base platform uses the Service Fulfillment Manager application to 
integrate Oracle Purchasing, Oracle Payables, Oracle Inventory, CRL Projects, 
Oracle Assets, and can integrate with legacy systems to synchronize and manage 
material flow in a company. The Oracle Enterprise Install Base platform minimizes 
data entry by using customer-definable business rules to send messages to all other 
related applications to perform the appropriate update when a business event 
occurs.

Oracle Enterprise Install Base utilizes Oracle Install Base as its data repository. 
Every transaction that Oracle Enterprise Install Base tracks is recorded in the Oracle 
Install Base transaction table, and each record affected by such transactions is 
recorded in the instance and instance history tables.

All setups are done through windows in Oracle Install Base or other products, 
including the setups for locations and parties.
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Inventory Item and Asset Tracking
1.2 Inventory Item and Asset Tracking
To track inventory items and assets, Oracle Enterprise Install Base must interact 
with several enterprise resource planning (ERP) applications. It sends to and 
receives messages from these applications about the status and location of the items 
that you want to track.

Oracle Enterprise Install Base provides an enterprise tracking and asset 
management system where all inventory, project, party, and asset-related material 
information is stored, providing a 360-degree view of your assets. You can locate 
materials anywhere in the system—in warehouses, on trucks, installed in the 
network, or on project sites—facilitating financial transactions using physical 
movements of material and equipment. In addition, Oracle Enterprise Install Base 
can provide a life-cycle history of all activity for that equipment.

An asset comprises a collection of items. The items may be trackable or not 
trackable. During implementation, items are designated as Oracle Enterprise Install 
Base-trackable at the master level in Oracle Inventory. Oracle Enterprise Install Base 
tracks the activity of the trackable items through inventory and projects, and into 
fixed assets. 

In Oracle Assets you perform the Mass Additions concurrent process to create 
assets.

As an example of message flows involving Oracle Enterprise Install Base, when a 
field service technician enters a report that equipment has been placed into service, 
the deployment transaction can send a message to Oracle Enterprise Install Base. 
This message updates the status of the equipment to In Service and gives its 
in-service date to Oracle Assets. The asset is now ready to be created in Oracle 
Assets.

1.2.1 Functions Supported by Oracle Enterprise Install Base
This application supports the standard functions found in Oracle Inventory, Oracle 
Purchasing, Oracle Assets, and Oracle Projects enabled for CRL Financials. 

Oracle Enterprise Install Base supports the following functions:

■ Purchase order receipt of items into Inventory

■ Purchase order receipt of items into operating projects

■ Move orders to issue an item either to a project or directly to a field location

■ Miscellaneous issue to a project or field location
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Item Parameters in Oracle Inventory
■ Miscellaneous receipt from a project or field location

■ Installation and un-installation of equipment

■ In-service/Out-of-service of equipment

■ Subinventory transfers

■ Inter-organization transfers

■ Miscellaneous receipts and issues

■ Placement of assets into or out of service

■ Retirement and reinstatement of the partial or full cost of an asset

■ Asset item moves and asset item transfers

■ Physical counts

■ Internal sales order shipment

1.2.2 Usage Codes
Oracle Install Base uses a number of location attributes to track the physical location 
of an item instance. The following are the values that are meaningful for Oracle 
Enterprise Install Base

■ In Inventory 

■ In Process

■ In Transit

■ Installed

■ In Service

■ Out of Service

1.3 Item Parameters in Oracle Inventory
Items are created in Oracle Inventory. In order that items can be tracked by Oracle 
Enterprise Install Base, you must set some parameters at the time you create the 
item in Oracle Inventory.

The main item parameters to set are:

■ Track in Install Base
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Item Parameters in Oracle Inventory
This is a check-box parameter. When set, it enables items to be tracked by 
transactions in and related to Oracle Install Base and Oracle Enterprise Install 
Base.

■ Create Fixed Asset

This parameter determines if an item is normal or depreciable. The parameter 
determines how an asset can be created from the item.

If the check box is selected, then the item becomes depreciable, and the asset is 
created upon receipt either in Oracle Inventory or in Oracle Projects. 

If the check box is left unchecked, then the item is regarded as normal, and the 
asset is created when put in service through an Oracle Enterprise Install Base 
deployment transaction.

1.3.1 Normal versus Depreciable Inventory Items
For a normal item, the asset is created after an item is put in service. The asset is 
created through Oracle CRL Projects based on standard inventory cost.

For a depreciable item, the asset is created when an item is received, either in Oracle 
Inventory or Oracle Projects. The asset is created by Oracle Enterprise Install Base 
with the purchase order cost, which can be adjusted later after the invoice is 
matched the purchase order.

Oracle Enterprise Install Base supports the following inventory transaction types for 
internal sales orders:

■ Sales Order Issue

■ Internal Order Direct Shipment

■ Sales Order Pick

■ Internal Order Pick

■ Internal Requisition In-Transit Receipt

■ Internal Order In-Transit Shipment

1.3.2 Asset Processing for Normal and Depreciable Inventory Items
The following diagram shows an overview of the asset processing options for 
normal and depreciable inventory items and their dependence on the Oracle 
Enterprise Install Base usage codes.
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The Messaging Architecture
Figure 1–2 Asset Processing for Normal and Depreciable Inventory Items

For more information, see Chapter 4, "Understanding Projects Integration", 
Chapter 5, "Understanding the Fixed Asset Architecture", and Chapter 6, "Using 
Oracle Enterprise Install Base".

1.4 The Messaging Architecture
The messaging architecture receives requests from external publishing systems in 
XML (eXtensible Markup Language) format. Based on the input requirements, the 
application updates the status and keeps a history of transactions for the trackable 
unit. Subsequently, the application publishes outgoing requests to the subscribing 
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The Messaging Architecture
systems for further processing. The publishing and subscribing systems include: 
Install Base, inventory, purchasing, payables, assets, projects, workforce 
management, and other legacy system.
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Understanding Inventory Integ
2

Understanding Inventory Integration

This topic group provides information about interaction between Oracle Enterprise 
Install Base and Oracle Inventory and discusses the functionality of transactions in 
Inventory. 

2.1 Item Instance and Transaction Records
When an item is initially received, typically by a purchase order, a receipt 
transaction occurs. The initial receipt transaction creates an instance record for the 
item in Oracle Enterprise Install Base. A receipt transaction record is associated with 
the item instance record. Subsequent transactions against this item will also be 
associated with the instance record and will compose the history for that record.

2.1.1 Transaction Types in Oracle Inventory
Oracle Enterprise Install Base supports the following inventory transactions types, 
for both normal and depreciable items:

■ Purchase order receipt in inventory

■ Move order and transact move order

■ Miscellaneous issue to a project

■ Miscellaneous receipt from a project

■ Miscellaneous receipt and miscellaneous issue

■ Subinventory transfer

■ Inter-organization transfer

■ Physical cycle count
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Oracle Enterprise Install Base supports the following inventory transaction types, 
for normal items only:

■ Project Contract Issue

■ Return to Vendor

■ Account Issue

■ Account Alias Issue

■ Project Borrow

■ Project Transfer

■ Project Payback

■ Cycle Count Transfer

■ Physical Inv Transfer

■ Backflush Transfer

■ Account Receipt

■ WIP Component Return

■ Account Alias Receipt

■ RMA Receipt

■ PO Rcpt Adjust

■ Int Req Rcpt Adjust

■ Shipment Rcpt Adjust

■ WIP Assy Completion

■ WIP Assembly Return

■ WIP Neg Comp Issue

■ WIP Neg Comp Return

For more information, see the Oracle Install Base User Guide.

2.1.2 Item Instance Creation and Update
In many transactions, item instances are created or updated. The number of item 
instances created depends on whether the master item in Oracle Inventory is 
designated to be a serialized or a non-serialized item.
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2.1.3 Item Instance Processing in Oracle Inventory Transactions
If an item is a serialized item, then an item instance is created for each separate 
item. If an item is a non-serialized item, an item instance is created that depends on 
a number of item attributes. 

The following diagram shows the factors that determine how an item instance is 
created or updated during the Oracle Inventory transactions that affect Oracle 
Enterprise Install Base.

Figure 2–1 Item Instance Processing in Oracle Inventory Transactions

2.2 Purchase Order Receipt into Inventory
Purchase order receipt flow is initiated by the creation of a purchase order. The 
items are then received into inventory against the purchase order when the 
shipment arrives from the vendor.

The Receipt into Inventory package validates the data against the Oracle Install 
Base repository and creates or update the unit record.

■ If an item is serialized, then a new instance will always be created.
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■ If an item is non-serialized, then Oracle Enterprise Install Base searches for the 
existing record. The search criteria are as follows: Inventory Item, Inventory 
Organization, Subinventory, Units of Measure, Instance Usage Code, Revision, 
Inventory Locator, Lot Number (if applicable). If the exact record is found, then 
the record will be updated with the new quantity. If not, then a new instance 
will be created.

■ Every receipt builds transaction history.

2.3 Receiving Items into Asset Subinventories
Use the following procedure to receive an item into an asset subinventory. If the 
item is not received in asset subinventory, then expenditures items will not be 
created in Oracle Projects

Prerequisites
At least one subinventory must exist. The item number must be defined in Oracle 
Inventory. The purchase order must exist in Oracle Purchasing with a status of 
Approved.

Steps
1. From the Inventory responsibility, navigate to Transactions > Receiving > 

Receipts.

The Organizations window opens.

2. Choose your organization from the Organizations window, and click Find.

3. In the Find Expected Receipts window, enter criteria that identifies the items 
that you are receiving, such as the purchase order number.

4. In the Receipt header, enter the packing slip number and any other pertinent 
information.

5. In the Receipt lines, verify the quantity to be received. 

You may receive a partial line quantity.

6. Verify that the destination subinventory entered on the purchase order is not 
depreciable.

7. Click Lot-Serial. 

If the item is under lot control, then enter the equipment code (CLEI) in the Lot 
field. 
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If the items are under serial control, then enter individual serial numbers or a 
range of consecutive numbers. You can also enter corresponding vendor serial 
numbers in the Manufacturing Serial Number field.

8. Choose File > Save to complete the receipt.

2.4 Move Orders
A move order transfers inventory:

■ From one stocking location to another

■ From a stocking location to a project

To create a move order, you manually create a move order requisition. After the 
move order requisition is approved, it becomes a move order. If the organization 
does not require approval, then the manual request automatically becomes a move 
order. 

You must define certain transaction types in Oracle Inventory for move orders, and 
you can define others. Two examples of Oracle Inventory transaction types for 
move orders are as follows:

■ Enterprise Install Base Move Order Issue to Project: creates a document for 
moving material from inventory to a project.

■ Enterprise Install Base Move Order Subinventory Transfer: creates a 
document for moving material from one subinventory to another subinventory. 
For more information, see Section 2.6, "Subinventory Transfers".

Of the two transaction types shown, the Issue to Project transaction type is a 
required transaction type, and the Subinventory Transfer is optional.

For more information, see the section "Define User-definable Transaction Types" in 
the Oracle Enterprise Install Base Implementation Guide.

2.4.1 Parts of a Move Order 
A move order comprises three parts:

■ The Move Order Header holds the move order number, an optional description 
of the move order, and information to default to the individual move order 
lines.
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■ The Move Order Lines are the actual move requests, including the item 
number, requested quantity, completed quantity, the source, and destination 
information.

■ The Line Details are the inventory transactions that occur to fulfill a move 
order line, including equipment code, serial number, quantity moved, source, 
and destination details (such as locators).

2.4.2 Move Order Approval Governed by Time-Out and Item Planner
At the organization level, three attributes—Move Order Time-out Period, Time-out 
Action, and Item Planner item—affect how move order requisitions are approved. If 
the move order requisition is not approved before the time-out period passes, then 
Oracle Workflow sends a reminder notice to the item planner. If the move order 
requisition is still not approved within a second time-out interval, then the 
requisition is automatically approved or rejected based on the Time-out Action 
setting. If no item planner is specified for the item, then the requisition line is 
approved automatically.

2.4.3 Creating a Move Order 
Create a move order when you need to transfer inventory across subinventories or 
into a project account.

Prerequisites
Inventory setups such as item, subinventory definition must be complete. 

You must have defined transaction types for move orders in Oracle Inventory.

If you use an Oracle Workflow process to route move order requisitions for 
approval, then the item must be assigned to an item planner.

Steps
1. From the Inventory responsibility, navigate to Move Orders > Move Orders.

2. In the Move Orders window, enter an order number in the Number field. 

If you do not insert a value, then the application fills the Number field. You can 
also enter a description of the order in the Description field.

3. In the Default region, enter the following information:

Transaction Type: Select a transaction type.
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This is one of the transaction types for move orders which you defined as 
user-defined transactions in Oracle Inventory. 

Note: the transaction Issue to Project must be Project based. 

For more information, see the section "Define User-definable Transaction 
Types" in the chapter "Dependency Module Setup", in the Oracle Enterprise 
Install Base Implementation Guide.

Date Required: Enter the requested delivery date. Also enter Ship-to 
Location, and Source and Destination subinventories. 

4. Enter the following information on the lines on each of the tabs:

■ Item: the item number, item revision (if under revision control), and 
quantity to move.

■ Project and Task

■ Source: source subinventory (if different from the default value), locator (if 
locator control is enabled), equipment code (CLEI), and serial numbers. If 
you do not know from what subinventory the item should be transferred, 
then click On Hand at the bottom of the window to search for material 
locations.

■ Destination: the destination subinventory or account, if different from the 
default value and the destination locator for a subinventory transfer type 
move order.

■ Control: the move order transaction type, if different from the default 
value, a predefined reason code, or alphanumeric reference information. 

If approval is required, then the item planner receives a Workflow notification that 
there are move order requisition order lines awaiting approval. The planner uses 
Oracle Workflow to approve the orders.

The item planner chooses Approve or Reject for each move order requisition line. If 
one requisition line on a move order is rejected, then other lines of the same move 
order can be approved.

Note: You do not have to enter Source details in the Creating a 
Move Order procedure. If you do not enter Source details in the 
Creating a Move Order procedure, you must enter them in the 
Transacting a Move Order procedure. See Section 2.4.4, "Transacting 
a Move Order".
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2.4.4 Transacting a Move Order
After a move order is approved, you transact the move order by performing the 
action described on the approved lines. Use this procedure to perform the approved 
transaction.   

Prerequisites
The move order must be approved.

Steps
1. In the Inventory responsibility, navigate to Move Orders > Transact Move 

Orders. 

2. Locate move orders that have been approved. 

You can query by header, line, source, or destination information.

3. To add details to the move order line, select the check box for each line that you 
wish to detail, and click Allocate.

Information is automatically entered on the transaction lines of the move order, 
based on the inventory picking rules and transaction defaults defined within 
the organization.

4. Click View/Update Allocations to view the detailed lines. 

You can manually update any information that is incorrect. Add missing 
information, such as equipment code (CLEI) and serial numbers.

5. If you do not require a pick slip, then click Transact to execute the detailed lines. 

If you need to print a pick slip, then save the transaction at this point. When the 
pick slip is ready, return to the Transact Move Orders window, select the line or 
lines to be executed, and click Transact. 

2.5 Miscellaneous Transactions
Oracle Enterprise Install Base supports the miscellaneous transactions (receipts and 
issues) used by Oracle Inventory. Each transaction in Oracle Inventory triggers a 
message to Oracle Enterprise Install Base. 

In Oracle Inventory, the value of an item quantity can be a negative number, such as 
when a miscellaneous issue from inventory causes the quantity of an item to fall 
below zero. For depreciable items, if a transaction causes a negative inventory 
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balance, then Oracle Enterprise Install Base adjusts asset units in Oracle Assets to 
zero, but it does not set the value in Oracle Assets to a negative number.

The topics in this section are as follows:

■ Miscellaneous Receipts

■ Miscellaneous Receipts from Projects

■ Miscellaneous Receipts from Field Location

■ Miscellaneous Issues

■ Miscellaneous Issues to Projects

■ Miscellaneous Issues to Field Location

For more information, see Oracle Inventory User’s Guide: "Performing Miscellaneous 
Transactions" and Oracle Assets User’s Guide: "Defining Locations and Defining 
Distributions."

2.5.1 Miscellaneous Receipts
Use miscellaneous receipts to receive material without a purchase order. In 
addition, you may also need to enter an equipment code (CLEI) in the Lot field, or a 
serial number.

■ If the item is serialized, then a new instance always is created.

■ If the item is non-serialized, then Oracle Enterprise Install Base searches for the 
existing record. The search criteria are as follows: Inventory Item, Inventory 
Organization, Subinventory, Units of Measure, Instance Usage Code, Revision, 
Inventory Locator, Lot Number (if applicable). If the exact record is found, then 
the record is updated with the new quantity. If not, then a new instance is 
created.

The following table summarizes the actions performed during the processing of 
the Miscellaneous Receipt transaction:

Table 2–1 Miscellaneous Receipt Transaction Processing

Serialized item Non-serialized item 

Check if item instance usage is Out of Service.

If Yes, update location.

If No, create new item instance.

Always create new item instance or 
update existing item instance.
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For a non-serialized item, Oracle Enterprise Install Base processes a miscellaneous 
receipt using the same procedures as those for a new receipt.

2.5.2 Miscellaneous Receipts from Projects
The Miscellaneous Receipt from Project transaction is used to transfer material from 
Oracle Projects back to Oracle Inventory. 

You must have defined the Miscellaneous Receipt from Project transaction in Oracle 
Inventory as part of the implementationof Oracle Enterprise Install Base. For more 
information, see the section "Define User-definable Transaction Types" in the Oracle 
Enterprise Install Base Implementation Guide.

The main considerations for the Miscellaneous Receipt from Project transaction ar 
as follows:

■ For a serialized item, the instance record is updated. The instance usage code 
changes to IN INVENTORY.

■ For a non-serialized item, a new instance is created with instance code = IN_
INVENTORY. If the record exists for the same instance, then that record is 
updated with the appropriate quantity. The search criteria are as follows: 
Inventory Item, Inventory Organization, Subinventory, Units of Measure, 
Instance Usage Code, Revision, Inventory Locator, Lot Number (if applicable).

■ Project expenditures are reversed by running the Cost Collection Manager 
program from Oracle Inventory and the transaction import from Oracle Project. 
This reduces the project cost with the transacted item cost.

The following table summarizes the actions performed during the processing of the 
Miscellaneous Receipt from Project transaction:

Note: The Miscellaneous Receipt transaction cannot be used to 
move the existing non-serialized item intances back to inventory.
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2.5.3 Miscellaneous Receipts from Field Location
The Miscellaneous Receipt from Field location transaction is used to receive assets 
from the the field location.

You must have defined the Miscellaneous Receipt from Field location transaction in 
Oracle Inventory as part of the implementation of Oracle Enterprise Install Base. For 
more information, see the section "Define User-definable Transaction Types" in the 
Oracle Enterprise Install Base Implementation Guide.

The main considerations for the Miscellaneous Receipt from Field location 
transaction are as follows:

■ For a serialized item, the instance record is updated. The instance usage code 
changes to IN_INVENTORY.

■ For a non-serialized item, a new instance is created with instance code = IN_
INVENTORY. If the record exists for the same instance, then that record is 
updated with the appropriate quantity. The search criteria are as follows: 
Inventory Item, Inventory Organization, Subinventory, Units of Measure, 
Instance Usage Code, Revision, Inventory Locator, Lot Number (if applicable). 
See also Section 2.1.3, "Item Instance Processing in Oracle Inventory 
Transactions".

Use this procedure to enter a miscellaneous receipt transaction.

Steps
1. Navigate to the Miscellaneous Transaction window.

2. Enter the date and time of entry for the transaction.

The date you can enter is controlled by the INV: Transaction Date Validation 
profile option. See: Oracle Inventory Profile Options.

Table 2–2 Miscellaneous Receipt from Project Transaction Processing

Serialized item Non-serialized item 

Check if item instance is In Process.

If Yes, update location, change usage 
to In Inventory.

If No, error.

Check if item instance is In Process.

If Yes, and if quantity is sufficient, then deduct 
quantity + item expenditure from the project item 
instance, and add quantity to the inventory item 
instance.

If No, error.
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3. Enter a miscellaneous transaction type for the transfer. This should the 
transaction you set up to receive assets from field location. See: "Defining 
Transaction Types" in Enterprise Install Base Implementation Guide.

4. Optionally, enter the source of the transaction type.

5. Optionally, enter the general ledger account against which the material is issued 
or received.

6. Optionally, indicate if inventory information should be defaulted from the serial 
number.

Use this procedure to enter the item to transfer.

Steps
1. Choose Transaction Lines in the Miscellaneous Transaction window. The 

Transaction Lines Detail folder window appears.

2. Enter an asset item want to receive. If you choose to default inventory 
information from the serial number, enter a serial number.

3. Enter the revision for the item to issue or receive. You must enter a value in this 
field if the item is under revision control.

4. Enter a subinventory. For an issue transaction, you cannot enter a subinventory 
that does not have Quantity Tracking turned on.

5. Enter a locator. You must enter a value here if you established locator control for 
the item.

6. Optionally, enter a lot number for the asset item. If you want to enter multiple 
lot numbers, complete the remaining steps, then choose the Lot/Serial button to 
display the Lot Entry window.

7. Enter a unit of measure. This can be the primary unit of measure (the default) or 
any valid alternate unit of measure. If you enter an alternate unit of measure, 
then Oracle Inventory issues the quantity that you specify in this unit of 
measure. Oracle Inventory also converts the quantity to the primary unit of 
measure so that it can correctly update the on-hand quantity.

8. Enter the quantity of the asset to receive, based on the unit of measure that you 
specified. 

9. If using average costing, enter the unit cost of the item to receive or issue. Leave 
this field blank to use the system average cost at the time of the transaction.
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10. Enter a location from where you are receiving an asset. You must enter the 
location field for this transaction type.

11. Optionally, enter a reason code for the transaction. For example, you can use 
reason codes to allow you to mark exceptional charges to support quality data 
collection.

12. Optionally, enter text that describe the transaction.

13. Enter a general ledger account for the item to use in the transaction. You can 
change this account only for miscellaneous issue/receipt or user-defined 
transaction types.

14. To enter lot or serial number information, choose the Lot/Serial button. 

15. Save your work to process the transaction.

2.5.4 Miscellaneous Issues
For miscellaneous issues, you can enter a lot number in the Lot field and a serial 
number for serial-controlled and lot-controlled items.

■ If the item is serialized, then the instance record is updated to zero quantity.

■ If the item is non-serialized, then Oracle Enterprise Install Base searches for the 
existing record. The search criteria are as follows: Inventory Item, Inventory 
Organization, Subinventory, Units of Measure, Instance Usage Code, Revision, 
Inventory Locator, Lot Number (if applicable). The record is updated to the 
appropriate quantity.

The following table summarizes the actions performed during the processing of the 
Miscellaneous Issue transaction:

2.5.5 Miscellaneous Issues to Projects
You must have defined the Miscellaneous Issue to Project transaction in Oracle 
Inventory as part of the implementationof Oracle Enterprise Install Base. For more 

Table 2–3 Miscellaneous Issue Transaction Processing

Serialized item Non-serialized item 

Set quantity to zero.

(Item instance will no longer appear 
in item instance searches.)

Reduce the on-hand quantity.
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information, see the section "Define User-definable Transaction Types" in the Oracle 
Enterprise Install Base Implementation Guide.

The Miscellaneous Issue to Project transaction works exactly the same way as the 
standard Move Order.

■ For a serialized item, the instance record is updated. The instance usage code 
changes to IN PROCESS.

■ For a non-serialized item, a new instance is created with instance code = IN 
PROCESS. If the record exists for the same instance, then that record is updated. 
The search criteria are as follows: Inventory Item, Inventory Organization, 
Subinventory, Units of Measure, Instance Usage Code, Revision, Inventory 
Locator, Lot Number (if applicable).

The following table summarizes the actions performed during the processing of the 
Miscellaneous Issue to Project transaction:

2.5.6 Miscellaneous Issues to Field Location
Use this transaction to issue item to a field location directly from the warehouse. 

Oracle Enterprise Install Base marks this transaction as an IN SERVICE transaction, 
and the asset can be created after  the transaction is complete. The asset location of 
the existing assets will be changed after running Interface Move and Misc 
Transactions to Fixed Assets - Report.

You must have defined the Miscellaneous Issue to Field Location transaction in 
Oracle Inventory as part of the implementation of Oracle Enterprise Install Base. For 
more information, see the section "Define User-Definable Transaction Types" in the 
Oracle Enterprise Install Base Implementation Guide.

For a serialized item, the instance record is updated. The instance usage code 
changes to IN SERVICE. For a non-serialized item, a new instance is created with 
instance code = IN SERVICE. If the record exists for the same instance, then that 
record is updated.

Table 2–4 Miscellaneous Issue to Project Transaction Processing

Serialized item Non-serialized item 

Change location.

Set usage code to IN PROCESS.

Reduce quantity from the inventory item instance, 
and increase quantity for the project item instance.
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The search criteria are as follows: Inventory Item, Inventory Organization, 
Subinventory, Units of Measure, Instance Usage Code, Revision, Inventory Locator, 
Lot Number (if applicable).

The following table summarizes the actions performed during the processing of the 
Miscellaneous Issue to Field Location transaction:

2.6 Subinventory Transfers
A subinventory transfer moves material inventory between subinventories. A 
subinventory is a unique physical or logical separation of material inventory, such 
as raw inventory, finished goods, or defective material. All material within an 
organization is held in one or more subinventories. 

A move order initiates a subinventory transfer. Oracle Enterprise Install Base 
handles these transfers in the same manner that Oracle Inventory handles them.

The way Oracle Enterprise Install Base processes a subinventory transfer is based 
initially on whether or not the transferred item has a serial number.

2.6.1 Items with a Serial Number
Oracle Enterprise Install Base searches the database for the From record associated 
with the item. This record must have an Oracle Enterprise Install Base usage code of 
IN INVENTORY. After Oracle Enterprise Install Base locates the record, it updates 
the item’s subinventory in the From record.

2.6.2 Items without a Serial Number
Oracle Enterprise Install Base searches the database for the From and To records. 
These records must have an Oracle Enterprise Install Base usage code of IN 
INVENTORY. After Oracle Enterprise Install Base locates the records, it updates the 
item’s subinventory in both the From and To records.

■ The source instance (the subinventory instance record from which the item is 
transferred) and the destination instance (the subinventory instance record to 

Table 2–5 Miscellaneous Issue to Field Location Transaction Processing

Serialized Item Non-Serialized Item 

Change location to the specified 
location.

Set usage code to IN SERVICE.

Reduce quantity from the inventory item instance, 
and increase quantity for the in-service item 
instance.
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which the item is transferred) is searched on the following criteria: Inventory 
Item, Inventory Organization, Subinventory, Units of Measure, Instance Usage 
Code, Revision, Inventory Locator, Lot Number (if applicable).

■ If both source and the destination records are found, then they are updated with 
transaction quantity. If either of the instance records is not found, then it is 
created.

For more information on how subinventory transfer are processed, see Oracle 
Inventory User’s Guide:

2.7 Inter-Organization Transfers
An inter-organization transfer moves items between organizations. This transfer can 
be either a direct or an in-transit transaction.

2.7.1 Direct versus In-Transit Transactions
In a direct transaction, a shipping organization transfers an item into a 
subinventory in the receiving organization. For this reason, the application treats a 
direct inter-organization transfer the same as a subinventory transfer.

For an in-transit transaction, the monetary value of the transferred item is 
deposited in an in-transit account, and the inventory account of the shipping 
organization receives credit for the item. Upon receipt of the transferred item, the 
receiving organization must perform a receipt transaction to bring the item into its 
inventory. The receipt transaction credits the in-transit account and debits the 
inventory account of the receiving organization.

2.7.2 Inter-Organization Transfers Tied to Oracle Inventory
Oracle Enterprise Install Base uses the same process that Oracle Inventory uses to 
transfer materials between organizations. Before items can be transferred, items 
must be defined and subinventories must be created in Oracle Inventory.

If the organization from which the item is being transferred does not allow negative 
inventory balances, then it must contain sufficient on-hand inventory for the 
transaction to occur.

2.7.3 Initial Step to Processing Inter-organization Transfers
If the inter-organization transfer is a direct transaction, then the application treats it 
the same as a subinventory transfer. 
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If the inter-organization transfer is an in-transit transaction, then the application 
searches the database for the From record associated with the item. This record 
must have a status of In Inventory or In Depreciable Inventory and a transaction 
status of Complete. If the item fails to meet these conditions, then it generates an 
error message.

There is no difference, from an Oracle Enterprise Install Base perspective, between a 
FOB Shipment or FOB Receipt type transaction.

2.7.4 Inter-Organization Transfers of Items with Serial Numbers
For an in-transit transfer of an item with a serial number from one organization to 
another, the application follows these steps:

1. In-Transit Shipment 

The source record for the From organization and subinventory is located. Then it is 
updated with the To organization and the Oracle Enterprise Install Base usage code 
of IN TRANSIT. The subinventory information is removed from the record. If the 
transaction is successfully processed, then transaction records are created to store 
the transaction history

2. In-Transit Receipt

When the item reaches its destination, someone enters a receipt transaction for the 
item. The IN TRANSIT record with the To organization is located, and it is updated 
with the usage code IN INVENTORY.

2.7.5 Inter-Organization Transfers of Items without Serial Numbers
For an In-Transit transfer of an item without a serial number from one organization 
to another, the application follows these steps:

1. In-Transit Shipment 

The source record for the From organization and subinventory is located, and the 
quantity is subtracted by the transaction quantity. An IN TRANSIT record is then 
created with the destination organization and transaction quantity. No subinventory 
information is kept in this record. If such a record already exists, then the quantity is 
increased by the transaction quantity.

2. In-Transit Receipt

When the item reaches its destination, someone enters a receipt transaction for the 
item. The IN TRANSIT record with the To organization is located. The quantity is 
subtracted with the transaction quantity. The destination record is located based on 
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the To organization and subinventory. If the record exists, then the quantity is 
increased by the transaction quantity. If there is no such record, then a new 
destination record is created. If the transaction is successfully processed, then 
transaction records are created to store the transaction history.

2.7.6 To and From Subinventory Type Must Be Compatible
A subinventory may have a type of either asset or expense.

For Oracle Enterprise Install Base, the only type of item transfer allowed is the 
following:

■ From asset subinventory to asset subinventory

If the type of the From subinventory does not match the type of the To 
subinventory, then the application generates an error.

2.8 Physical Cycle Counts
A physical inventory occurs when a person verifies that units exist physically and 
that the quantities match the on-hand records in Oracle Enterprise Install Base. 
Based on the results of the physical inventory, Oracle Enterprise Install Base 
supports adjustments that you make to your inventory balances. Depending on the 
type of inventory adjustment necessary, Oracle Enterprise Install Base treats these 
adjustments like a miscellaneous transaction. For example, if the item quantity 
increases after physical count, then there will be miscellaneous receipt transaction.

See also:

■ Section 2.5, "Miscellaneous Transactions"

2.9 Asset Handling for Internal Sales Orders
Oracle Enterprise Install Base performs cost and unit adjustments to assets when 
they are moved using internal sales orders. This handling applies to depreciable 
and normal items that have Oracle Assets assets associated with them.

The integration of Oracle Enterprise Install Base with Oracle Assets supports the 
following Oracle Inventory transactions. Item definition as Depreciable or Normal 
must be kept at the master organization level and must not be changed at 
organization level.

■ Direct Inter-Organization Transfers

■ In-Transit Inter-Organization Transfers
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■ Direct Internal Sales Order 

■ In-Transit Internal Sales Order

In the case of in-transit shipments, item instances are in transit until they are 
received into a receiving organization. Such in-transit transactions interact with 
Oracle Assets only upon receipt of the material or item in the receiving inventory 
organization. 

Oracle Enterprise Install Base does not maintain Instance-Asset links for in-transit 
instances.

Oracle Enterprise Install Base performs the following updates based on the item 
definition: 

■ Depreciable Items: Update the fixed asset location if it is different from the 
source and destination location. If the asset category is different, then update 
the asset cost and units of the source asset and create or update the destination 
asset.

■ Normal Items with Assets: In case of redeployment, serialized normal items 
have fixed assets associated with them. If any of the inter organization 
transactions are performed, then these transactions are also required to interact 
with Oracle Assets. Update the fixed asset location if it is different from the 
source and destination location. If the asset category is different, then update 
the asset cost and units of the source asset and create or update the destination 
asset.

All of the inter-organization transfer and internal sales order transactions are 
processed by Oracle Enterprise Install Base-Oracle Assets integration as asset move 
transactions.

Typically all of the transactions and various scenarios can be broadly categorized as 
indicated in the following table.
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To avoid inventory costing conflicts for assets, receive and store capitalized items in 
separate expense-type subinventory. In addition, keep the inventory asset flag 
cleared if you do not wish to create assets upon miscellaneous receipts.

Case #

Shipping Org 
"Inventory" 
Usage Code 
Instance 
Serialized or 
Non-Serialized

Receiving Org 
"Inventory" 
Usage Code 
Instance 
Serialized or 
Non-Serialized

Actions with Oracle Enterprise Install 
Base and Oracle Assets 

1 Serialized Serialized The application performs an Oracle 
Assets location change if the source and 
destination asset locations are different 
or if the source asset category is different 
from the destination asset category. Then 
it retires the source asset and creates a 
new asset in the destination organization.

2 Serialized Non-Serialized The application retires the source 
serialized instances. Then it creates or 
updates the destination asset.

3 Non-Serialized Serialized The application performs asset cost and 
unit adjustment on the source asset and 
creates serialized destination assets.

4 Non-Serialized Non-Serialized The application performs an Oracle 
Assets location change if the source and 
destination asset location are different or 
if the source asset category is different 
from the destination asset category. Then 
it performs negative cost adjustment on 
the source asset and creates or updates 
the destination asset.
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Understanding Asset Deployment

This topic group describes how to deploy assets using Oracle Enterprise Install 
Base.

3.1 Asset Deployment
Asset deployment is a capability of Oracle Enterprise Install Base. The purpose of 
asset deployment is to signal the completion of operational tasks, to update item 
statuses in Oracle Install Base, and to initiate the asset creation and update 
processes in Oracle Projects and Oracle Assets.

Oracle Enterprise Install Base can be integrated with external workforce 
management systems. Oracle Enterprise Install Base provides an interface API as 
well as the Asset Deployment window for an external workforce management 
application to transmit transaction parameters to Oracle Enterprise Install Base.

For an overview of the asset operations and their dependence on Oracle Enterprise 
Install Base usage codes, see Section 1.3.2, "Asset Processing for Normal and 
Depreciable Inventory Items".

The topics in this chapter are as follows:

■ Section 3.1.1, "Asset Deployment Transactions"

■ Section 3.1.2, "Partial Installation and In-Service Conditions"

■ Section 3.1.3, "Selecting the Location for the Item Instance"

■ Section 3.1.4, "The Search Item Instances Page"

■ Section 3.1.5, "Setting Item Instance Usage Code to Installed"

■ Section 3.1.6, "Setting Item Instance Usage Code to In Service"

■ Section 3.1.7, "Setting Item Instance Usage Code to Uninstalled"
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■ Section 3.1.8, "Setting Item Instance Usage Code to Out-of-Service"

■ Section 3.1.9, "Moving the Item"

■ Section 3.1.10, "Resetting Item Instance Usage Code to In-Service"

3.1.1 Asset Deployment Transactions
Figure 3–1 shows the life cycle flow of an item instance, with the asset deployment 
and Oracle application transactions that change the Oracle Enterprise Install Base 
usage codes for the item instance.Asset deployment transactions in item instance 
life cycle flow.
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Figure 3–1 Asset Deployment Actions in Item Instance Life Cycle Flow
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3.1.2 Partial Installation and In-Service Conditions
When material is issued from inventory to a project, a cost expenditure is created in 
Oracle Projects that includes the quantity and the cost of material. Oracle Enterprise 
Install Base creates the appropriate expenditures in Oracle Projects after the 
equipment is placed in service. Further processing by Oracle Projects programs 
creates assets based on these expenditures.

You can capitalize some or all of the material assigned to a project. For example, 
assume that ten items have been issued to the project. A technician installs five and 
then places only three items in service. This means that only three (or a cost 
expenditure equal to 3 times the unit cost) are capitalized immediately. Expenditure 
will be capitalized only after the associated equipment (asset) is deployed in 
service.

3.1.3 Selecting the Location for the Item Instance
In all the asset deployment transactions, to accurately track an item instance, you 
must select the current location of the item instance.

There are a number of options that are common to all the selections for the location 
of an item instance.

The value for the location can be an internal site or an external party site. 

When entering location information, you must first select a Location Type from the 
following list:

■ Party Site

■ HZ Location

■ Network Location

If you select Party Site for the Location Type, then you must select a party into the 
Party field.

If you select either HZ Location or Network Location for the Location Type, then 
you must select a location into the Location field. The list of values for the Location 
field depends on your selection of Location Type:

■ If you select HZ Location, then the list of values for the Location field displays 
the Addresses as set up in the Trading Community Architecture (TCA) 
locations.
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■ If you select Network Location, then the list of values for the Location field 
displays the network locations and Addresses as set up in the Trading 
Community Architecture (TCA) locations.

3.1.4 The Search Item Instances Page
When you log into Oracle Enterprise Install Base, the Search Item Instances page 
appears. It has the following default regions:

Quick Find
Use this when you already know a unique identifier for an item instance, such as a 
serial number or a sales order number.

Search Item Instances
Within this region you can define and display searches according to saved criteria.

Saved Searches
Use this to create, save, and use personalized, named search criteria.

Search Results (untitled)
The untitled region below Saved Searches displays the results of your most recent 
search. From here you can view details of listed items and perform other operations 
on them.

After you have performed a search, the result list appears in the Search Item 
Instances page. The functions available to perform on entries on this list are as 
follows:

Expire Item Instances button
Marks the entry as a candidate for expiry with an end date of today, when you click 
Update. A list of values is displayed for update of status for the expired instance. 
Status choices include, for example, Returned, Terminated, and Return for 
Replacement.

Description link
Displays the General Attributes region of a Item Instance Details page.

For details on using the general features of these regions, refer to the Oracle Install 
Base User Guide.
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View Configuration icon
Displays the Item Instance Configuration page. There you can view item instance 
configurations by relationship type and version, expire relationships, and add and 
create subitems.

View Detail icon
Displays the most frequently used attributes of the instance on one page.

Copy button
Displays the Copy Item Instance page. There you can use the copy of the item 
instance definition to define another item instance. The Copy Item Instance page is 
very similar to the Create Item Instance page reached with the Create button. The 
main difference is that the Copy Item Instance page already has supplied some 
values. The Copy button is available only for item instances that are at a customer 
location. 

Update button
Changes the status of entries with the Remove box selected to Expired and puts 
the current date and time as the end date and end time. Changing an item instance 
status to Expired does not remove the item instance from Oracle Install Base. 

Create button 
Displays the Create Item Instance page. There you can define a new item instance.

Download button
Downloads and saves the search summary results to an Excel file.

View Details column 
Provides an LOV containing links for direct access to details of item category 
attributes. The default value in the speed menu link is populated from the profile 
option CSI: UI Default Selection of View Details Dropdown.

3.1.5 Setting Item Instance Usage Code to Installed
Material issued to the project is installed at a specific location. The Installed 
operation assigns a certain physical location to the equipment. In Oracle Enterprise 
Install Base, this transaction changes the Oracle Enterprise Install Base usage code 
of the item instance to Installed. This is the prerequisite if you want to put the item 
in service and capitalize it further. 
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Prerequisites
The item instance must have been moved to the project, and have a usage code of 
In-Process.

Steps
1. Using the Oracle Enterprise Install Base responsibility, navigate to the Search 

Item Instances page.

2. Search the instances using specific search criteria. Refer to The Search Item 
Instances Page section for more information about this page.

3. Select each instance that you want to deploy in service by selecting its 
corresponding Select check box.

4. Select Project Item Installed for the value of Transaction Type. 

The In Service transaction type is not correct for this scenario. Use the In Service 
transaction type only if the item is moved and has a usage value of Item Move.

5. Click Go. 

The Project Item Installed page appears. The application automatically omits 
the instances that do not fulfill the prerequisite. For example, any instances that 
are not in the In Process status are omitted in the Install transaction.

6. Enter the deployment order. Deployment order is the work order number used 
to deploy the item.

7. Change the value for Transaction Quantity if necessary.

8. Select the location type. The list of locations changes according to the location 
type selected. Party name is necessary only if the party site is selected as the 
location.

9. Click Submit.

The item instances are updated with the Oracle Enterprise Install Base usage 
code set to In Service.

3.1.6 Setting Item Instance Usage Code to In Service
In Oracle Enterprise Install Base an In Service transaction makes non-depreciable 
items eligible for capitalization. The Oracle Enterprise Install Base usage code 
changes to In Service. The In Service location must be the same as that for Installed, 
otherwise the transaction errors out. Take out the part otherwise the transaction 
errors out.
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If you do not want to use the same location as Installed, then perform the Project 
Item Uninstall transaction first and then install it at the location where you want to 
put it into service.

Prerequisites
The item instance must have been moved to the project, and have a usage code of 
Installed.

Steps
1. Using the Oracle Enterprise Install Base responsibility, navigate to the Search 

Item Instances page.

2. Search the instances using specific search criteria. Refer to The Search Item 
Instances Page section for more information about this page.

3. Select each instance that you want to deploy in service by selecting its 
corresponding Select check box.

4. Select Project Item In Service for the value of Transaction Type. 

The In Service transaction type is not correct for this scenario. Use the In Service 
transaction type only if the item is moved and has a usage value of Item Move.

5. Click Go. 

The Project Item In Service page appears. The application automatically omits 
the instances that do not fulfill the prerequisite. For example, any instances that 
are not in the Installed status are omitted in the In Service transaction.

6. Enter the deployment order. Deployment order is the work order number used 
to deploy the item.

7. Change the value for Transaction Quantity if necessary.

8. Change the date placed in service if necessary. 

The date placed in service has a financial significance rather than actual 
physical transaction. Use this date to start the depreciation of the asset. If you 
use a date for which asset book depreciation is not current, then the asset is not 
created. For example, if the current depreciation date for your asset book is July 
and if you put the date placed in service in August, then the asset will not be 
created until the asset book depreciation is open for August. It is not necessary 
that the date placed in service is same as the date at which the actual transaction 
is performed. The date at which the deployment is actually performed will be 
recorded as the transaction date. 
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9. Click Submit.

The item instances are updated with the Oracle Enterprise Install Base usage 
code set to In Service.

3.1.7 Setting Item Instance Usage Code to Uninstalled
Projects under construction can be scrapped totally or can have extra materials. In 
any case, installed items are sent back to inventory. Oracle Enterprise Install Base 
supports these transactions. 

Installed items can be uninstalled partially or fully and sent back to inventory 
through a miscellaneous transaction. Oracle Enterprise Install Base handles these 
for normal as well as depreciable items. Unit adjustments are done immediately. To 
reverse the expenditure items and balance the project cost, you must run the Cost 
Collection Manager program in Oracle Inventory. It creates the negative 
expenditures for uninstalled items.

Prerequisites
The item instance must have been moved to the project, and have a usage code of 
Installed.

Steps
1. Using the Oracle Enterprise Install Base responsibility, navigate to the Search 

Item Instances page.

2. Search the instances using specific search criteria. Refer to The Search Item 
Instances Page section for more information about this page.

3. Select each instance that you want to deploy in service by selecting its 
corresponding Select check box.

4. Select Project Item Uninstalled for the value of Transaction Type. 

5. Click Go. 

The Project Item Uninstalled page appears. The application automatically omits 
the instances that do not fulfill the prerequisite. For example, any instances that 
are not in the Installed status are omitted in the Project Item Uninstalled 
transaction.

6. Enter the deployment order. Deployment order is the work order number used 
to uninstall the item.

7. Change the value for Transaction Quantity if necessary.
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8. Click Submit.

The item instances are updated with the Oracle Enterprise Install Base usage 
code set to In Process. This transaction has no financial impact.

3.1.8 Setting Item Instance Usage Code to Out-of-Service
Equipment that is in service can be taken out of service for maintenance purposes or 
for can be transferred to another location. The Out of Service transaction is meant 
for the same uses. Specify the location type and the location from which the item is 
taken out of service.

Prerequisites
The item instance must have been moved to the project, and have a usage code of In 
Service.

Steps
1. Using the Oracle Enterprise Install Base responsibility, navigate to the Search 

Item Instances page.

2. Search the instances using specific search criteria. Refer to The Search Item 
Instances Page section for more information about this page.

3. Select each instance that you want to deploy in service by selecting its 
corresponding Select check box.

4. Select Out of Service for the value of Transaction Type. 

5. Click Go. 

The Out of Service page appears. The application automatically omits the 
instances that do not fulfill the prerequisite. For example, any instances that are 
not in the In Service status are omitted in the Out of Service transaction.

6. Enter the deployment order. Deployment order is the work order number used 
to take the item out of service.

7. Change the value for Transaction Quantity if necessary.

8. Click Submit.

The item instances are updated in Oracle Enterprise Install Base with the usage 
code set to Out of Service. Asset depreciation does not change by taking an 
asset out of service.
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3.1.9 Moving the Item
Use the Item Move transaction if you want to move the equipment having the usage 
code Out-of-Service. The application asks for the To and From locations. The Item 
Move transaction does not change the usage code of the item instance.

Prerequisites
The item instance must have a usage code of Out-of-Service.

Steps
1. Using the Oracle Enterprise Install Base responsibility, navigate to the Search 

Item Instances page.

2. Search the instances using specific search criteria. Refer to The Search Item 
Instances Page section for more information about this page.

3. Select each instance that you want to move by selecting its corresponding Select 
check box.

4. Select Item Move for the value of Transaction Type.

5. Click Go. 

The Item Move page appears. The application automatically omits the instances 
that do not fulfill the prerequisite. For example, any instances that are not in the 
Out of Service status are omitted in the Item Move transaction.

6. Enter the deployment order. Deployment order is the work order number used 
to move the item.

7. Change the value for Transaction Quantity if necessary.

8. Select the location type. The list of locations changes according to the location 
type selected. Party name is necessary only if the party site is selected as the 
location.

9. Click Submit.

The item instances are updated in Oracle Enterprise Install Base, but the usage 
code remains set to Out of Service.

3.1.10 Resetting Item Instance Usage Code to In-Service
The In Service transaction is only for the existing In-Service assets, which were 
moved from one location to the other. This transaction puts the asset in service 
again at a new location. The item instance usage code changes to In-Service again.
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Prerequisites
The item instance must have been moved to the project, and have a usage code of 
Out of Service.

Steps
1. From the Search Item Instances page, search the instances using specific search 

criteria. Refer to The Search Item Instances Page section for more information 
about this page.

2. Select each instance that you want to deploy in service by selecting its 
corresponding Select check box.

3. Select In Service for the value of Transaction Type. Do not select Project Item In 
Service for the value of Transaction Type

4. Click Go. 

The In Service page appears. The application automatically omits the instances 
that do not fulfill the prerequisite. For example, any instances that are not in the 
Out of Service status are omitted in the In Service transaction.

5. Enter the deployment order. Deployment order is the work order number used 
to uninstall the item.

6. Change the value for Transaction Quantity if necessary.

7. Click Submit.

The item instances are updated with the Oracle Enterprise Install Base usage 
code set to In Service.
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Understanding Projects Integration

This topic provides an understanding of the interaction between Oracle Enterprise 
Install Base and Oracle Projects, as well as the functionality of Oracle Projects. 

4.1 Purchase Order Receipt into Project
The flow of purchase order receipts starts with the creation of a purchase order. 
Items against the purchase order are then received into the project. The Oracle 
Enterprise Install Base purchase order receipt package validates the receipt data 
against the Oracle Install Base repository and creates or updates the repository 
instance depending upon the physical attributes of the instance.

■ For non-serialized items, physical attributes are combinations of values for 
Inventory Item, Project ID, Task ID, and Instance Status. If any values of these 
attributes are different, then the application creates a new instance in Oracle 
Install Base. If these attributes match, then the application adds the new receipt 
to the same instance.

■ For serialized items, Oracle Install Base always creates a new instance.

The following figure shows the factors that determine how an item instance is 
created or updated during the Oracle Projects transactions which affect Oracle 
Enterprise Install Base.
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Figure 4–1 Item Instance Processing in Oracle Projects Transactions

■ During the process of creating purchase orders for expense items, that is, receipt 
into project, you must clear the Accrue On Receipt Flag check box for purchase 
order shipments and select the destination type as EXPENSE.

■ Run the PRC Transaction Import process to create project expenditures after 
receipt is complete. Use the Expenditure Inquiry window in Oracle Projects to 
view the expenditures. 

■ For a depreciable item, an asset is created upon receipt. Therefore, the cost is 
transferred from Oracle Assets to Oracle General Ledger and not from Oracle 
Project.

4.1.1 Receiving Items Directly into an Oracle Project
Use the following procedure to receive an item into an operating project.
 

Prerequisites
The associated purchase order must exist in Oracle Purchasing with a status of 
Approved. The purchase order line must include: 

■ The project and task numbers for the item

■ A cleared check box for Accrue Upon Receipt

■ The expense destination type

Note: A depreciable item can also be received directly into a 
project.
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The item number must be defined in Oracle Inventory. The project must be defined 
with a status of Active.

Steps 
1. From the Inventory responsibility, navigate to Transactions >Receiving > 

Receipts.

The Organizations window opens.

2. Choose your organization from the Organizations window, and click Find.

3. In the Find Expected Receipts window, enter any criteria that identify the items 
that you are receiving such as the purchase order number and the item number, 
and click Find.

The Receipt Header and Receipt Lines open to display items that match the 
criteria entered.

4. In Receipt Header, enter the packing slip number and any other pertinent 
information.

5. Verify that the Receipt line has a value for Deliver-to location. 

When project information has been entered on the purchase order, the 
Deliver-to location is defined and appears on this Receipt line. 

6. Click Save to receive the item into the project and commit the receipt 
transaction.

The application looks for an existing record for the item. If it locates a record 
and the receipt transaction has processed successfully, then it updates the item 
record with the quantity received. 

If the application does not find an existing record, then it creates one for the 
receipt. The application sets the Oracle Enterprise Install Base usage code to In 
Inventory and its Oracle Install Base transaction status to Complete. 

Note: The Deliver-to location must be set up in the Oracle 
Enterprise Install Base Locations window and have an associated 
fixed asset location.
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4.2 Transaction Sources for Project Import
Transaction sources identify the source of external transactions that you import into 
Oracle Projects using Transaction Import. For example, you can define the 
transaction source Payroll to identify expenditure items imported from an external 
payroll system. Transaction Import imports the transactions and creates 
corresponding expenditure records in the Oracle Projects expenditure tables. The 
following are Oracle Enterprise Install Base transaction sources:

■ CSE_INV_ISSUE: Use this transaction for importing expenditures of type Issue 
to Project for a normal item

■ CSE_INV_ISSUE_DEPR: Use this transaction for importing expenditures of 
type Issue to Project for a depreciable item

■ CSE_IPV_ADJUSTMENT: Use this transaction for cost to be adjusted to the 
project

■ CSE_IPV_ADJUSTMENT_DEPR: Use this transaction for cost to be adjusted to 
the asset

■ CSE_PO_RECEIPT: Use this transaction for type Receipt into Project for a 
normal item

■ CSE_PO_RECEIPT_DEPR: Use this transaction for type Receipt into Project for 
a depreciable item

■ INVENTORY MISC: Use this transaction for miscellaneous transactions such as 
Miscellaneous Issue and Miscellaneous Receipt

4.3 Expenditure Inquiry
After the expenditure records are created through Transaction Import, use the 
Expenditure Inquiry window to review a project’s expenditure items. You can see 
the amount and type of expenditure items charged to a project, how much revenue 
has accrued for an expenditure item, and other information about the project’s 
expenditure items. For normal items that came through inventory, the expenditures 
are not created until the concurrent process PRC Distribute Usage and 
Miscellaneous Costs is run.

For more information, see Oracle Projects User’s Guide: Transaction Import.
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4.4 Asset Creation
After expenditures are created in projects, you can create an asset. The following 
steps are required for creation of an asset:

1. Run the Oracle Projects program PRC: Generate Asset Lines for a Single Project.

2. Run the Oracle Projects program PRC: Interface Assets to Oracle Asset.

3. Run the Oracle Assets request set Post Mass Additions.

See also Section 1.3.2, "Asset Processing for Normal and Depreciable Inventory 
Items".

The topics in this section are the following:

■ Section 4.4.1, "PRC: Generate Asset Lines for a Single Project"

■ Section 4.4.2, "PRC: Interface Assets to Oracle Asset"

4.4.1 PRC: Generate Asset Lines for a Single Project
Use this concurrent program to generate summary asset lines for a single project.

Prerequisites
None.

Steps
1. From the CRL 11i Projects responsibility, navigate to Projects > Other > 

Requests > Run.

2. Choose to run either a single report.

3. In the Name field, choose PRC: Generate Asset Lines for a Single Project

4. Click Submit.

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request window.

References
Section 6.1.1, "Viewing Request Results"
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4.4.2 PRC: Interface Assets to Oracle Asset
Use this concurrent program to send valid asset lines to Oracle Assets to become 
fixed assets. The process creates one mass addition line in Oracle Assets for each 
asset line in Oracle Projects, assigning the asset information you entered for the CIP 
asset to the mass addition line in Oracle Assets.

Prerequisites
None.

Steps
1. From the CRL 11i Projects responsibility, navigate to Projects > Other > 

Requests > Run.

2. Choose to run either a single report.

3. In the Name field, choose PRC: Interface Assets to Oracle Asset.

4. Click Submit.

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request window.

References
Section 6.1.1, "Viewing Request Results"
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Understanding the Fixed Asset Architecture

This topic provides an understanding of the interaction between Oracle Enterprise 
Install Base and Oracle Assets. 

5.1 Asset Processing in Oracle Enterprise Install Base
Oracle Enterprise Install Base can interface assets directly to Oracle Assets by using 
concurrent programs. After an asset is created, any physical movement to the 
associated item automatically updates the financial records. This reduces the 
amount of manual intervention required to maintain your financial system.

For example, when a depreciable item is received, run the Create Assets: Interface 
Inventory Transactions to Fixed Asset program to create an asset. Now the asset is 
linked with the item. Suppose an item is moved to a different organization. Oracle 
Enterprise Install Base checks for necessary changes for asset location, and asset 
category if applicable. Accordingly, Oracle Enterprise Install Base makes the 
necessary changes to the asset, which may involve retiring an existing asset and 
creating a new asset in the new organization.

Oracle Enterprise Install Base also maintains the history of all the transactions 
performed. This gives you total visibility of all items and their related assets.

When Oracle Enterprise Install Base creates a transaction that has a financial, 
asset-related impact, the transaction is stored in a transaction table with an Oracle 
Install Base status of Pending. Later, a concurrent program reads the transaction log 
and processes all the transactions in sequence. The Oracle Enterprise Install Base 
concurrent program processes each transaction in the transaction table one by one. 
The program determines the appropriate asset record if applicable, inserts a record 
into the fixed asset interface table, and then changes the Oracle Install Base status to 
Complete. If any of these processes fails, then the status reverts to the pending 
stage. 
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A user can review the asset records in the asset interface table if necessary before 
posting them to the asset book. For more information, refer to the section on 
reviewing mass addtions lines in the Oracle Assets User Guide. A tieback from Oracle 
Assets returns the asset ID to the Oracle Enterprise Install Base business logic or 
client extension and updates the Oracle Install Base Instance-Asset assignment 
table. 

5.2 Asset-Related Processes in Oracle Enterprise Install Base
Table 5–1 shows the concurrent programs and request sets in Oracle Enterprise 
Install Base that interface with Oracle Assets to make the asset-related changes in 
Oracle Assets.

See also Section 1.3.2, "Asset Processing for Normal and Depreciable Inventory 
Items"Asset Processing for Normal and Depreciable Inventory Items.

The topics in this section are the following:

■ Section 5.2.1, "Create Assets: Interface Inventory Transactions to Fixed Asset"

■ Section 5.2.2, "Asset Header for Normal Item Report"

■ Section 5.2.3, "Interface Move and Misc Transactions to Fixed Assets - Report"

Table 5–1 Processes to Create and Update Oracle Assets

Name of the Program 
or Report Description

Create Assets: Interface 
Inventory transactions 
to Fixed Asset 

This is a concurrent program with the following features:

■ Creates an asset or cost adjustment when a 
depreciable item is received either in Oracle 
Inventory or Oracle Projects

■ Creates an asset or cost adjustment when a normal 
item is issued to a field location directly without 
using projects

Asset Header for 
Normal Item Report

This concurrent program creates an asset header for 
capitalized project expenditures. Asset creation is based 
on item number, asset category, book type code, project, 
and task.

Interface Move and 
Misc Transactions to 
Fixed Assets - Report

This is a concurrent program that processes any item 
moves like subinventory transfer, inter-organization 
transfer, miscellaneous issues, and physical inventory 
adjustments for which an asset already exists.
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5.2.1 Create Assets: Interface Inventory Transactions to Fixed Asset
The Create Assets: Interface Inventory Transactions to Fixed Asset concurrent 
program processes the following transactions to create an asset for a depreciable 
item.

Process Steps:
Perform the following steps after receipt of a depreciable item to create an asset:

1. Run the Create Assets: Interface Inventory Transactions to Fixed Asset from 
Oracle Enterprise Install Base.

2. Run Post Mass Additions from Oracle Assets.

Requirements
■ For project related receipts, the billable flag is already set to NO to prevent 

account information from going to general ledger and thus avoid double 
accounting.

■ Because Ship to Location is a mandatory field on a purchase order, the 
corresponding fixed asset location is used to create an asset. The asset category 
is extracted from the item definition.

Table 5–2 Transactions for the Create Assets Program

Install Base Transaction Source Description

Install Base 
Transaction 
Status Meaning

PO_RECEIPT_INTO_
INVENTORY

Receipt of 
depreciable item into 
Inventory

PENDING Needs further 
fixed 
asset/project 
accounting 
processing

PO_RECEIPT_INTO_PROJECT Receipt of 
depreciable item into 
Projects

PENDING Needs further 
fixed 
asset/project 
accounting 
processing

Miscellaneous/Move Order Issue 
to an HZ Location 

Miscellaneous/move 
order issue to an HZ 
location 

PENDING Needs further 
fixed 
aset/project 
accounting 
processing
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■ The fixed asset book type is used from the Oracle Enterprise Install Base profile 
option CSE:FA Book Type Code.

■ Vintage pooling is available for all non-serialized depreciable items. Any receipt 
is added to the existing asset if the receipt year is the same. Receipt date must 
be defaulted to the first day of the current fiscal year. However, you can 
customize it through client extension.

■ In the case of serialized item instances, a new asset is always created. For 
non-serialized item instances, a new asset is created if the asset category is 
different or, in case of vintage pooling, if the receipt year is different.

■ If the asset already exists for that category, then the application adjusts the cost 
and unit.

After the post mass additions program is complete, the asset number is linked to the 
item instance.

5.2.2 Asset Header for Normal Item Report
The Asset Header for Normal Item concurrent program processes the following 
transactions to create an asset for normal items put in service.

Steps
Perform the following steps after a normal item is put in service to create an asset:

1. Run the concurrent request set EIB: Asset Header for Normal Item concurrent 
program from Oracle Enterprise Install Base.

2. Run the concurrent program PRC: Generate Asset Lines for a Single Project 
from Oracle Projects.

3. Run the concurrent program PRC: Interface Asset to Oracle Assets from Oracle 
Projects.

4. Run the concurrent request set Post Mass Additions from Oracle Assets.

Table 5–3 Transactions for the Asset Header for Normal Item Program

Install Base 
Transaction Source Description

Install Base Transaction 
Status Meaning

PROJECT_ITEM_IN_
SERVICE

Item put in 
service

INTERFACE_TO_PA Needs further 
fixed 
asset/project 
accounting 
processing.
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Guidelines:
■ An item must be issued to a project or received in the project before installing 

and putting it in service. Also make sure to create expenditures before 
installing. This is a prerequisite for asset creation. Expenditures are created by 
running the Project Transaction Import program. The details are covered in the 
Projects Integration section.

■ If you run this program without creating expenditures, then this program 
creates project expenditures but not the asset.

■ In the case of serialized item instances, a new asset is always created. For 
non-serialized item instances, a new asset is created if asset category is different.

■ If the asset already exists for that category, then the program performs cost and 
unit adjustment.

■ A fixed asset location corresponding to the network location is used to create an 
asset. Asset category is extracted from the item definition.

■ The fixed asset book type is used from the Oracle Enterprise Install Base profile 
option CSE:FA Book Type Code.

After successful completion of Post Mass Additions, the asset is created or updated 
for the new in-service item instance.

5.2.3 Interface Move and Misc Transactions to Fixed Assets - Report
The Interface Move and Misc Transactions to Fixed Assets - Report concurrent 
program is generally run after an asset has been created and is used to update the 
asset-related information associated with Oracle Enterprise Install Base.

If the program is run, and any assets that it expects to update have not yet been 
created, then the update transaction information is help pending, so that it can be 
processed later, after the necessary asset creation program or request set has been 
run.
Understanding the Fixed Asset Architecture 5-5



Asset-Related Processes in Oracle Enterprise Install Base
The Interface Move and Misc Transactions to Fixed Assets - Report concurrent 
program processes the following transactions for each asset associated with the item 
instance that is transacted.
PROJECT

Table 5–4 Transactions Processed by the Interface Move and Misc Transactions to 
Fixed Assets Program

Install Base Transaction Source Description

Install Base 
Transaction 
Status Meaning

MISC_ISSUE Miscellaneous 
issue of item out 
of inventory

PENDING Needs further 
fixed asset/project 
accounting 
processing

PROJECT_ITEM_UNSTALLED Item is 
Un-installed 
from the project

PENDING Needs further 
fixed asset/project 
accounting 
processing

MISC_RECEIPT_FROM_PROJECT Item is moved 
from Projects into 
Inventory

PENDING Needs further 
fixed asset/project 
accounting 
processing

SUBINVENTORY_TRANSFER Transfer of an 
item within the 
organization 
from one 
subinventory to 
another

PENDING Needs further 
fixed asset/project 
accounting 
processing

INTERORG_TRANSFER Transfer of an 
item from one 
organization to 
the other

PENDING Needs further 
fixed asset/project 
accounting 
processing

MOVE_ORDER_ISSUE_TO_
PROJECT

Item issued to the 
project

PENDING Needs further 
fixed asset/project 
accounting 
processing

PROJECT_ITEM_INSTALLED Equipment 
Installed

PENDING Needs further 
fixed asset/project 
accounting 
processing
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PROJECT_ITEM_IN_SERVICE Equipment 
In-service

PENDING Needs further 
fixed asset/project 
accounting 
processing

IN_SERVICE Asset is put in 
service

PENDING Needs further 
fixed asset/project 
accounting 
processing

PHYSICAL_INVENTORY, 
CYCLE_COUNT

Asset adjustment 
when the item is 
adjusted in 
inventory in 
physical count

PENDING Needs further 
fixed asset/project 
accounting 
processing

ISO_SHIPMENT Item is shipped 
through internal 
order shipment

PENDING Needs further 
fixed asset 
processing

Table 5–4 Transactions Processed by the Interface Move and Misc Transactions to 
Fixed Assets Program

Install Base Transaction Source Description

Install Base 
Transaction 
Status Meaning
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Prerequisites

Generally, you must have run the two concurrent processes for asset creation, 
Depreciable Items - Asset Creation and EIB: Create Assets for Normal Items, to 
completion.

Steps
1. Run the concurrent program Interface Move and Misc Transactions to Fixed 

Assets - Report from Oracle Enterprise Install Base.

2. Run Post Mass Additions from Oracle Assets.

Note:
■ In the case of a depreciable item, the movements listed in Table 5–4 are tracked 

because an asset is created upon item receipt. For a normal item, only asset item 
move transactions are tracked.

■ The program checks for any asset updates due to change in location. For 
example, when item is issued to the project, the location is changed from 
inventory to project location. If these locations belong to different fixed asset 
locations, then this change causes different distribution in the asset. Interface 
Move transactions to Fixed Asset process this change. 

■ All the transactions are processed sequentially, because of dependence. If any 
dependent transaction is pending, then this transaction is skipped

5.3 Asset Impact of a Miscellaneous Issue
For serialized items, when an item is issued out of inventory, the associated asset 
units and cost are both set to zero.

For non-serialized items, when an item is issued out of inventory, the associated 
asset units and cost are both reduced by the equivalent values in the transaction.

Oracle Enterprise Install Base retires a field asset while processing a Miscellaneous 
Issue transaction.

5.4 Asset Impact of Subinventory Transfers
When an item is transferred from one subinventory to another, the program 
changes fixed asset location which, in turn, changes the fixed asset distributions. 
The asset, however, remains the same.
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In a situation where there exists more than one source record, the First-in-first-out 
method is adapted. If more than one destination asset record exists, then the asset 
year is matched to adjust the asset. When searching for the existing asset in the 
system, the program always looks to see if there exists a similar record under 
process. If it finds an exact match, then the record is skipped.

In a business rule dictates a change in location with a change in category, then you 
must modify the client extension. In that case, a new set asset is created for a 
serialized item. The original asset cost is updated to zero, and you have to retire the 
asset manually. Similar unit and cost adjustments are done in source and 
destination assets in the case of non-serialized items.

5.5 Asset Impact of Inter-Organizational Transfers
When an item is transferred from one organization to another, the program changes 
fixed asset location which, in turn, changes the fixed asset distributions. The asset, 
however, remains the same. The transactions include IN_SERVICE, MISC_
RECEIPT_FROM_PROJECT, PROJECT_ITEM_IN_SERVICE, and ISO_SHIPMENT.

■ Intra-asset: If only one source asset exists, and if the destination record has the 
same asset but the fixed asset location is different, then that is changed.

■ Inter-asset: If the source asset and the destination assets are different, then the 
program performs cost and unit adjustment for both assets.

■ If there is no destination asset, then the program creates a new asset with the 
transaction quantity and appropriate cost. Then the cost and unit adjustments 
are done for the source asset. In the case of serialized items, the original asset 
cost is updated to zero, and you must retire the asset manually.

In a situation where more than one source record exists, the first-in-first-out method 
is adapted. If more than one destination asset record exists, then asset year is 
matched to adjust the asset. When searching for the existing asset in the system, the 
program always determines if a similar record exists under process. If it finds an 
exact match, then the record is skipped.

If your business rule dictates a change in location for a change in category, then you 
must modify the client extension. In that case, a new asset is created for a serialized 
item. The original asset cost is updated to zero, and you must retire the asset 
manually. Similar unit and cost adjustments are done in source and destination 
assets in the case of non-serialized items.
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5.6 Asset Impact of Physical Inventory and Cycle Count Adjustments
Depending upon the physical adjustment, a Physical Inventory and Cycle Count 
Adjustments transaction is treated the same as Miscellaneous Issue or 
Miscellaneous Receipt. For example, if an item quantity increases after a physical 
count, then a Miscellaneous Receipt transaction is performed, and the asset is 
adjusted accordingly. See Section 2.5.1 and Section 2.5.2 for more details. 

After a Physical Inventory and Cycle Count Adjustments transaction, run the 
concurrent program Interface Move Transactions to Fixed Assets - Report program. 
Finally, run the Post Mass Addition request set from Oracle Assets to complete the 
asset information update. 

5.7 Case Study 
The case study scenario consists of a number of item transactions, followed by the 
processing used to create and update the assets associated with the items.

The topics in this section are as follows:

■ Section 5.7.1, "Case Study Item Transaction Details"

■ Section 5.7.2, "Asset Processing Options"Section 5.7.3, "Case Study Asset 
Processing"

5.7.1 Case Study Item Transaction Details
Table 5–5 describes the item transactions for this case study.

Table 5–5 Case Study Item Transaction Details

Transaction Type Transaction ID Quantity Details

Receipt of Depreciable item D1 1 100 Item D1 in Organization A

Receipt of Normal item N1 2 100 Item N1 in Organization B

Inter-Organization Move 3 25 Item D1 from Org A to Org C

Receipt of Depreciable item D2 4 20 Item D2 in Organization A

Move Order Issue to Project 5 25 Item N1 from Organization B 
to Project P1

Equipment installed 6 15 Item N1 from Project P1 
installed in field location F1
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Figure 5–1 shows the case study transactions related to the item organizations, 
project, and locations. 

Figure 5–1 Case Study Transactions

Equipment put in service 7 5 Item N1 put in service in field 
location F1

Equipment taken out of service 8 1 Item N1 taken out of service 
at field location F1

Item Move 9 1 Item N1 from field location 
F1 to field location F2

Equipment put back in service 10 1 Item N1 put in service in field 
location F2

Table 5–5 Case Study Item Transaction Details

Transaction Type Transaction ID Quantity Details
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5.7.2 Asset Processing Options
Oracle Enterprise Install Base processes three types of asset transaction, using the 
following processing units: 

■ Section 5.2.1, "Create Assets: Interface Inventory Transactions to Fixed Asset"

This is a concurrent program which creates an asset.

■ Section 5.2.2, "Asset Header for Normal Item Report"

This is a request set which creates an asset header that becomes an asset 
through CRL concurrent programs.

■ Section 5.2.3, "Interface Move and Misc Transactions to Fixed Assets - Report"

This is a concurrent program which performs asset updates, both depreciable 
and normal, due to physical moves.

5.7.3 Case Study Asset Processing
1. Run the Depreciable Items - Asset Creation concurrent program. This selects 

transactions 1 and 4. It checks if assets already exist for items D1 and D2. If 
assets already exist for items D1 and D2, then the program performs unit and 
cost adjustments to the existing assets. Otherwise it creates new assets.

2. Now, if you run the program Interface Move Transaction to Fixed Assets - 
Report, then only transaction 3 is selected and will be processed to make asset 
updates, assuming that an asset had been previously successfully created for 
item D1. 

Although transaction 10 is also a asset move, it is not selected this time. This is 
because Item N1 has not yet become an asset (you cannot create assets from 
normal items unless the items are in service).

3. Now, run the request set EIB: Create Assets for Normal Items. At this point, 
transaction 7 is selected and the asset header will be created. This will become 
an asset after running CRL programs for asset creation.

4. Transaction 10, where the normal item N1 was put back in service in location 
F2, will be selected and processed only when you run the Interface Move 
Transactions to Fixed Assets Report program subsequently.

To ensure the proper order of the transactions, the program skips all the failed 
transaction records and their subsequent dependent transaction records. 
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For example, in the case study, assume that for some reason an asset was not 
created for item D1 in transaction 1 when the Depreciable Items - Asset Creation 
concurrent program was run.

Transacton 3 depends on transaction 1. If transaction 1 fails to create an asset, then 
transaction 3 will not be processed by the program Interface Move Transaction to 
Fixed Assets - Report. 

Transaction 3 will be processed only when you perform the following processing 
sequence:

1. Run the Depreciable Items - Asset Creation program, and check that you have 
successfully created an asset for the parent transaction 1.

2. Run the Interface Move Transaction to Fixed Assets - Report program.

5.8 Understanding the CLEI
The Common Language Equipment Identifier (CLEI) is a vendor-specific, 
10-character code. It is a standard used by the telecommunications industry for 
identifying and describing equipment. Because Oracle Enterprise Install Base 
captures the CLEI code in the lot field, items that have a CLEI code must be set to 
full lot control. If an item has no CLEI code, then it does not need lot control.

The supplier usually provides CLEI codes for the items that you purchase. When 
performing transactions, you can select CLEI codes from a list of values or you can 
enter new CLEI values directly into the Lot field.

5.9 Overview of Retirements
The process that Oracle Enterprise Install Base uses to retire and reinstate assets is 
the same as the process used in Oracle Assets. You can retire or reinstate partial or 
whole assets.

Before you retire an asset, you must first take it out of service. If the asset being 
retired is in a depreciable subinventory, then Oracle Enterprise Install Base updates 
the status of the Instance-Asset link to Retired. 

An asset must have a status of retired before it can be reinstated. An asset 
reinstatement reverses the operation of the Oracle Enterprise Install Base retirement 
logic. For the reinstatement, Oracle Enterprise Install Base updates the the status of 
the Instance-Asset link to In Service.
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Using Oracle Enterprise Install
6

Using Oracle Enterprise Install Base

This topic group provides process-oriented, task-based procedures for using the 
application to perform essential business tasks.

6.1 Submitting a Request
Use the Submit Request window to request one of the following reports and 
concurrent processes in Oracle Enterprise Install Base:

■ Section 6.2, "Requesting an Assumed Loss Rate Report"

■ Section 6.3, "Requesting a Bill of Lading Report"

6.1.1 Viewing Request Results
When you request a report, Oracle Enterprise Install Base assigns a number to your 
request, runs the request, and stores the report. Use this procedure to view the 
report that you requested.

Prerequisites
You must request a report and save the request ID number.

Steps
1. In the Oracle Enterprise Install Base responsibility, navigate to Requests > View.

2. In the Find window, click Specific Request, and enter the ID number of the 
report that you wish to view. 

3. Click Find to retrieve the record.

4. Click View Output to see the report online.
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Requesting an Assumed Loss Rate Report
If the report was completed with errors, then choose View Log to see a list of 
the errors that were encountered when your request was processed. 

5. To print the report, in the Menu Bar choose Tools > Reprint. 

Enter the number of copies to print, the printer, and the print style. 

6. Click Save to complete the reprint request.

6.2 Requesting an Assumed Loss Rate Report
Use this procedure to generate a list of items that have been issued to projects but 
have never been placed in service. 

Prerequisites
None.

Steps
1. In the Oracle Enterprise Install Base responsibility, navigate to Requests > Run.

2. Choose to run a single report.

3. In the Name field, choose Assumed Loss Rate Report.

4. Choose either Detail or Summary report type. 

The Detail type displays all individual transactions that meet your criteria. The 
Summary type provides only transaction totals.

5. In the Parameters window, enter any needed information in the fields to define 
your search. 

If you leave all optional fields blank, then the search returns all records across 
all organizations in the format that you requested. 

Project Number: To limit your search results to those items that have been 
issued to a specific project, enter the project number here.

Task Number: Enter the task number to further limit your search results to 
those items that have been issued to a particular task for a project.

Organization: To limit your results to a particular organization, enter that 
organization here.

Inventory Item: To limit your search results to records for a specific item, 
enter the item number here.
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6. Click OK to close the Parameters window.

7. Click Submit when you have finished defining the report. 

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request window.

References
Section 6.1.1, "Viewing Request Results"

6.3 Requesting a Bill of Lading Report
Use this procedure to generate a bill of lading report, which displays the following:

■ move order number

■ transaction request date

■ ship-to location name and address

■ project number

■ task number

■ line item number

■ item number

■ item revision

■ quantity requested and quantity shipped, both with totals for each item number

■ CLEI

■ serial number

■ vendor serial number

Follow these steps to generate a bill of lading.

Prerequisites
None.

Steps
1. In the Oracle Enterprise Install Base responsibility, navigate to Requests > Run.

2. Choose to run a single report.
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3. In the Name field, choose Bill of Lading Report.

4. In the Parameters window, enter any necessary information in the fields to 
define your search. 

If you leave all fields blank, then the report will include all move orders for the 
current day.

Move Order Number: To limit the report to a specific move order, enter that 
number here.

Organization Name: Limits the report to a specific organization.

Date From: To limits the report to all move orders generated from a specific 
date forward, enter that date here.

Date To: To limit the report to all move orders generated before a specific 
date, enter that date here.

Project Number: To limit the report to only those move orders for a specific 
project, enter that project number here.

Task Number: To limit the report to only those move orders for a particular 
project task, enter that task number here.

Location: To limit the report to only those move orders for a particular 
physical location, enter that location here.

5. Click OK to close the Parameters window.

6. Click Submit when you have finished defining the report. 

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request form.

References
Section 6.1.1, "Viewing Request Results"

Guidelines
To print a bill of lading for a specific range of dates, enter a date in both the Data 
Required From and Data Required To fields. If you do not enter any dates in these 
fields, then the bill of lading report shows all move orders up to the system date.

If you enter a value for Task Number, then enter a corresponding Project Number.

To keep the report results to a manageable length, enter data for as many of the 
parameter fields as possible.
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6.4 Invoice Price Variance
For depreciable items, Oracle Enterprise Install Base creates item assets at PO cost. 
For normal items, Oracle Enterprise Install Base creates project expenditures with 
inventory cost.

After the invoice is created, any cost difference must be adjusted in project 
accounting or fixed asset applications. For the depreciable items, the difference is 
adjusted in Oracle Assets. For non-depreciable items, the adjustment is done in 
Oracle Projects.

For both normal and depreciable items, in Oracle Payables, the invoice must be 
approved, and accounting must be created. Also you need to run an Oracle 
Payables concurrent program to interface the transaction to Oracle General Ledger 
before adjusting the invoice price variance.

You need to run a concurrent program to ensure that the construction cost of the 
project is as close to the actual cost as possible. 

Two types of invoice price variance are available:

1. Invoice Price Variance in Oracle Projects 

To adjust the cost from Oracle Payables, you need to bring in invoice cost from 
Oracle Payables into Oracle Projects and then assign attributes to new expenditures. 
The steps are as follows:

a. Run the program PRC: Interface Payables Invoice Cost Adjustments to 
Projects Report.

b. Run the program PRC: Transaction Import.

c. Assign attributes to the new expenditure in the Expenditure Inquiry 
window, basing your assignment on asset category, location, and product.

2. Invoice Price Variance in Oracle Assets

To adjust the cost from Oracle Payables, bring the invoice cost from Oracle 
Payables into Oracle Assets, and then update the Mass Addition table. The 
steps are as follows:

a. Run the program PRC: Interface Payables Invoice Cost Adjustments to 
Assets Report.

b. Run the Oracle Assets request set Post Mass Additions for the category 
book. 

The topics in this section are the following:
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■ Section 6.4.1, "PRC: Interface Payables Invoice Cost Adjustments to Assets 
Report"

■ Section 6.4.2, "PRC: Interface Payables Invoice Cost Adjustments to Projects 
Report"

6.4.1 PRC: Interface Payables Invoice Cost Adjustments to Assets Report

Prerequisites
In Oracle Payables, first approve the invoice, then create accounting for the invoice.

Run the Oracle Payables program Payables Transfer to General Ledger.

Steps
1. From the Oracle Enterprise Install Base responsibility, navigate to Requests > 

Run.

2. Choose to run a single report.

3. In the Name field, choose PRC: Interface Payables Invoice Cost Adjustments to 
Assets Report.

4. In the Parameters window, enter the parameters From Invoice Accounting Date 
and the To Invoice Accounting Date. 

5. Click OK to close the Parameters window.

6. Click Submit when you have finished defining the report. 

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request window.

References
Section 6.1.1, "Viewing Request Results"

6.4.2 PRC: Interface Payables Invoice Cost Adjustments to Projects Report

Prerequisites
In Oracle Payables, first approve the invoice, then create accounting for the invoice.

Run the Oracle Payables program Payables Transfer to General Ledger.
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Steps
1. From the Oracle Enterprise Install Base responsibility, navigate to Requests > 

Run.

2. Choose to run a single report.

3. In the Name field, choose PRC: Interface Payables Invoice Cost Adjustments to 
Projects Report.

4. In the Parameters window, enter the parameters Project ID, GL Date, and End 
Expenditure Item Date and the To Invoice Accounting Date. 

5. Click OK to close the Parameters window.

6. Click Submit when you have finished defining the report. 

The application assigns an ID number to your request. Use the ID number to 
find your request in the View Request window.

References
Section 6.1.1, "Viewing Request Results"

6.5 Finding Personal Profile Values
In the Find Personal Profile Values window, you can search for the personal profile 
values that have already been defined in other Oracle applications. Then use the 
Personal Profile Values window to display and make changes to your personal 
settings. Do not enter user values unless you require a setting that is different from 
the default setting.

Follow these steps to find and edit personal profile values used in the Oracle 
Enterprise Install Base application.

Prerequisites
Create profiles. 

Steps
1. In the Oracle Enterprise Install Base responsibility, navigate to Setup > Profiles.

The Find Personal Profile Values window opens.

2. Click [...] to open the list of values.

The Organizations window appears.
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3. Enter any partial search mask, if you want, in the Find field, and click Find.

The Profiles window displays the profiles for Oracle Enterprise Install Base.

4. Select the profile that you want to edit, and click OK.

The Find Personal Profile Values window displays the name of the selected 
profile.

5. Click Find.

The Personal Profile Values window opens and displays the selected profile.

6. Enter values in the User Value column to customize the user profile.

7. Click File > Save to save your changes. 
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